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ABSTRACT
DIETRICH, AARON Kinetic and Mechanistic Investigations of Photocatalysis:

Photoreactions of Cr(CO)s with Alkenes. Department of Chemistry,
June, 1998.

Flash photolysis has proven to be an effective technique for determining
reaction mechanisms. Upon photolysis, a CO ligand is removed from Cr(CO)s
forming the reactive molecular fragment Cr(CO)s. In the presence uf alkene, L,
Cr(CO)s can react to form the meta-stable intermediate Cr(CO)sL. AthighL
concentrations, Cr(CO)sL decays by pseudo-first-order kinetics with an observed
rate constant, Kops, which is dependent on the concentration of both L and added
CO. The exast nature of the dependence provides insight into the mechanism of
the decay of Cr(CO)sL and a plot of 1/keps vs. [L] will give the rate constants for

both the dissociation and formation of this complex.
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Introduction

Organotransition metal compounds have a long history and participate in a
wide variety of reactions from synthesis to catalysis, as well as many others.
Zeise’s salt, K[PtCl(C,Hg)]H2O, discovered in 1827 by the Danish chemist W. C.
Zeise, was the first organotransition metal compound synthesized. Another major
discovery that increased the attention on organotransition metal compounds was
that of Ziegler’s catalyst. In 1953 Karl Ziegler discovered that a mixture of TiCl,
and AIE#; could be used to catalyze the polymerization of ethylene. The
discovery of Ziegler’s catalyst was closely followed by another industrially
important discovery, the Wacker process. The Wacker process, discovered in
1956 can be used o convert ethylene to acetaldehyde via a palladium-ethylene
intermediate. These discoveries illustrated the usefulness of organotransition
metal compounds and encouraged research towards acquiring a more thorough
understanding of the types of reactions in which organotransition metal
compounds participate.

A common use for organotransition metal compounds is as catalysts and
catalytic precursors. A requirement of any reaction is that the reacting molecules
be near each other. Often an organotransition metal compound can be used to
facilitate the bringing together of two species spatially. For example, by
coordinating an olefin to an organotransition metal compound a wide range of
reactions previously unlikely to occur can be facilitated. One such reaction

involves Wilkinson’s catalyst, RhCI(PPh;);, which can be used to catalyze the

hydrogenation of alkenes. In this reaction, the thodium atom is used to bring




together the alkene and a hydrogen molecule. Wilkinson’s catalyst and Ziegler’s
cata'yst are just two examples of the usefulness of organotransition metal
compounds as catalysts.

Ziegler’s catalyst and Ziegler-type catalysts have proven to have many
industrial uses. In addition to catalyzing the polymerization of ethylene they have
been shown to catalyze the polymerization of propylene, cyclic olefins, and other
alkenc systems. Olefin metathesis, a ligand exchange reaction, which has been
acquiring more attention recently, has also been shown to be catalyzed by Ziegler-
type catalysts.

Another class of reactions that also commonly plays a role in the catalytic
cycle is that of insertion, or ligand substituti n, reactions. Insertion reactions,
whereby a molecule is inserted into a transition metal-substituent bond, is often an
elementary step in the reaction of organotransition metal catalysts. Subsequent
elimination, or deinsertion, is commonly a final stage in the catalytic cycle and
leads to the regeneration of a coordinatively unsaturated organotransition metal

complex. Along with studies on the catalytic applications of organotransition

metal complexes, work has also been done on their kinetic and mechanistic

behavior. Through a more thorough knowledge of the mechanism, steps can be
taken towards improving the efficacy of catalysts by making them more efficient,
selective, and cost effective.

One experimental method commonly used for elucidating reaction
mechanisms is flash photolysis. Upon absorption of a photon many

organotransition metal compounds convert to energetically excited molecular




fragments, often by loss of one or more ligands. These highly reactive fragments
can often act as excellent catalysts or precursors to catalysts. The photochemistry
of chromium hexacarbonyl, Cr(CO)s, has been studied extensively for over
twenty years. Photolysis of Cr(CO)s has been shown to catalyze 1,4-
hydrogenation and 1,4-hydrosilylation of 1,3-dienes, and to catalyze many other
reactions as well.

The photoinitiated reactions of Cr(CO)s with alkenes has been an active
area of research. Typically, the first step in thcse reactions is loss of one or more
CO ligands from Cr(CO)s to produce Cr(CO)s.n (n = 1,2, 3, 4). The ability of
Cr(CO)s., to coordinate one or more alkenes via the alkene’s n-bond allows for
many types of interesting reactions, as stated earlier. Upon coordination, a meta-
stable organotransition metal-alkene complex is typically formed. In addition to
studying the reactions of these complexes with other molecules, information
about the nature of the activated complex itself can be obtained by monitoring the
decay of these complexes with various alkenes.

Extensive work has been done on the photolysis of Cr(CO)s in the
presence of olefins in the gas phase. In each case, the mechanism for the decay of
the meta-stable organotransition metal complex has been found to be dissociative.
It is the goal of this research to carry out a similar study on photolysis of Cr(CO)s
in the solution phase in the presence of a number of alkenes to determine the
effect of olefin size and electron donating ability on the kinetic lability of
Cr(CO)s-alkene coraplexes. Our kinetic studies to date suggest thata dissociative

mechanism is present and preliminary rate constants for the dissociation and




formation of the meta-stable organotransition metal-alkene complex have been

obtained.




Literature

Use of Cr(CO); as a photocatalyst

Organotransition metal compounds have many uses as catalytic precursors
and as catalysts. They can typically be used under mild reaction conditions and
typically bind with high selectivity. Thesc &xvorable properties have stimulated
much research on organotransition metal compounds. Wrighton and Schroeder
presented two of the earliest papers on the use of Cr(CO)s as a photocatalyst.
First, in 1973 they published a paper on the use of Cr(CO)g as a catalyst in the
hydrogenation of 1,3-dienes.! Secondly, in 1974 another paper was published
describing a process by which Cr(CO)s could be used to catalyze 1,4-
hydrosilation of 1,3-dienes.2

An important result of their work was the discovery that the diene must be
able to adopt the s-cis conformation in order for catalysis to be successful.> They
found their product to be greater than 99% isomerically pure using gas
chromatography. It is probable that the diene must bond as a bi-dentate ligand
and thereby bring both double bonds spatially close to the chromium atom. This
facilitates electron transfer from both double bonds via the chromium atom. This
requirement leads to a high degree of stereoselectivity and thereby allows one to
have a large amount of control over the structure of the products.

Another discovery was that the reaction is truly photocatalytic as opposed

to photoassisted.' In a photocatalytic reaction light is initially used to generate the

catalytically active species but is not required as the catalyst is reformed during




the catalytic cycle. In a photoassisted reaction product generation would shut
down when the light was shut off.
Photolysis of naked Cr(CO)s

An important step in understanding the role organotransition metal
compounds play in catalysis lies in understanding their reactivity in the absence of
added ligands. It is generally accepted that the primary photoproduct of Cr(CO)s
is Cr(CO)s. However, it was not until 1973 thata detailed mechanism describing
the fate of Cr(CO)s was presented. Kelly and co-workers presented a mechanism
whereby Cr(CO)s expels a CO ligand upon photolysis and generates the
coordinatively unsaturated Cr(CO)s. Cr(CO)s then adds to either CO or X, an

impurity in the system.” That mechanism is outlined below.

crco),  —sCrco) +Co (1)

Cr(CO), + CO—>Cr(CO), @

Cr(CO)5 +X —— Cr(CO)4 X 3
Kelly and co-workers also report a derived rate constant for reaction 2, the
recombination of CO with Cr(CO)s, of 31e10°M's™.

Using UV/VIS detection, a peak was observed at 503+5nm immediately

after the flash. This peak decayed with a lifetime of more than 200ps. In the
presence of latm of CO however, this peak disappears with a half-life of 25us.

A peak was also observed at 445nm and assigned to Cr(CO)sX. This peak

disappeared due to ensuing substitution by CO and had a half-life of 25s. Their




work demonstrated the high reactivity of coordinatively unsaturated Cr(CO)s and

the importance of removing all impurities from the system.

Solvation of photo-generated Cr(CO)s

An important consideration when dealing with such a highly reactive
species in solution is it’s interaction with the solvent. In 1983 Kelly and co-
workers investigated this issve by photolyzing Cr(CO)s in both a coordinating and
a non-coordinating solvent.* They selected perfluoromethylcyclohexane, C:F14,
as their non-coordinating solvent based on previous matrix studies® and
cyclohexane, CH,3, as their coordinating solvent. The use of cyclohexane is
important since it is a very common solvent in organometallic photochemistry and
most likely behaves similarly to other common hydrocarbon solvents.
Immediately after laser flash photolysis in CsF 4 a peak assigned to “naked”
Cr(CO)s was observed at 620nm at a time of Sns. However in a C7F14/CeH 2
(0.25M) mixture an absorbance maxima was observed at 485+10nm. This is
consistent with what was observed by Kelly in 1973 when Cr(CO)s was
photolyzed in cyclohexane.3

Once again in 1983 Kelly and co-workers had difficulty with impurities.
They found it difficult to reproduce data and found that a method of performing
freeze-pump-thaw cycles on the solution to remove dissolved gases was
successful in improving their reproducibility. The impurity complex they
observed prevented them from investigating the Cr(CO)s-(CsH2) complex further

since they both have a maximum absorbance around 500nm. They were able to

compare the reaction of CO with Cr(CO)s in both the coordinating and non-




coordinating solvent. They found that CO reacts 3 orders of magnitude faster in
C;Fy4 than in CgH 3, thus illustrating the important role the solvent plays in the

kinetics of these coordinatively unsaturated organotransition metal complexes.

Reactions of Solvated Cr(CO)s (Non-Alkene Ligands)

In addition to research into the solvation of coordinatively unsaturated
Cr(CO)s, work has also been done on the mechanism of desolvation of Cr(CO)sS.
Zhang and co-workers performed flash photolysis studies on the displacement of
benzene from Cr(CO)s(n’>-Benzene) in the presence ligand, L (L = piperidine, 1-

hexene, pyridine).6 Upon displacing benzene the ligand, L, reacts with Cr(CO)s

to form Cr(CO)sL whose subsequent decay could also be studied. Cr(CO)s(n’-

Benzene) is formed in less than Sus under their experimental conditions, and has
a maximum absorption at 458+10nm. By performing experiments over a wide
range of benzene and L concentrations, they were able to show that the decay of
Cr(CO)s(n*Benzene) is pseudo-first-order and follows a dissociative mechanism.
A dissociative mechanism is analogous to an organic Sy1 reaction in that the
outgoing ligand dissociates from the complex prior to the attack of the incoming
ligand. The outgoing ligand plays no role in the bonding of the incoming ligand.
An alternative would be an associative mechanism. This is analogous to an
organic Sx2 reaction in which the outgoing ligand remains bound to the complex
until the incoming ligand is coordinated.

Using Xenon flash photolysis and IR detection, Grevels and co-workers
found evidence for the presence of Cr(CO)sNa in N; flushed solutions of Cr(CO)s

at room temperature.” Upon photolysis they observed the solvated form of




Cr(CO)s and upon it’s disappearance five new bands in the infrared were
observed. These bands, only observed in N, flushed solution, were attributed to
Cr(CO)sN,. They obtained a rate constan for the first order formation of
Cr(CO)sN; of 18,000s”. Monitoring the disappearance of Cr(CO)sN; at 1978cm’
! they obtained a rate constant of 1.7s”'. While Grevels and co-workers do not
provide conclusive evidence for the mechanism of Cr(CO)sN; disappearance, they
suggest that a simple dissociation into Cr(CO)s and N; is a probable first step in
light of the observed first order behavior.

Grevels and co-workers reported similar findings in 1985 for a Cr(CO)sH;
complex.® Upon disappearance of Cr(CO)sS they observed two new bands at
1974cm™ and 2092cm™ which they attributed to a Cr(CO)sH; complex. A rate
constant of 19,000s™ for the formation of Cr(CO)sH; was obtained. They also
found evidence that the decay of Cr(CO)sH, proceeds via a dissociative pathway
with a first order rate constant of 2.5s". It is interesting to note that the rate

constants for formation of Cr(CO)sN and Cr(CO)sHa, 18,0005 and 19,000s™

respectively, as well as those for dissociation, 1.7s" and 2.55™! respectively,

suggesting that these two species have similar stability’s.

Work has also been done on the dissociation of various phosphine ligands
from Cr(CO)s. Wovkulich and Atwood studied the dissociation of Cr(CO)sL
(L = P(CgHs)s, P(OC¢Hs)s, P(OCH;)s, and As(CsHs)s) and found that it followed a
first order dissociative mechanism as well.’

The reactions of photolyzed Cr(COjs with silanes has been an active

research area due to Cr(CO)s’s importance in catalysis, as noted earlier. Inan




attempt to better understand the role Cr(CO)s plays in the catalytic cycle, Zhang
and co-workers measured the kinetic stability of many Cr(COs)(silane) complexes
with silanes that have widely varying steric and electronic properties.'0 Much of
their work was carried out under pseudo-first-order conditions with an excess of
CO and silane. Under these conditions, it was found that the mechanism of silane
displacement from Cr(CO)s(silare) follows a dissociative mechanism. They also
found that the rate of dissociation of Cr(CO)s(silane) decreased with increasing

electron-donor ability in the silane.

Reactions of Solvated Cr(CO)s with Alkenes

Qur own interests are with the kinetic and thermodynamic stability of
transition metal-alkene complexes. As stated earlier, these can be prepared by
photolytic cleavage of a metal-CO bond followed by addition of alkene. Itis
thought that the alkene bonds to the transition metal via its n-bond.

Photolyzing Cr(CO)s in liquid xenon doped with C;Hs, Poliakoff and co-

workers, using IR detection, found evide. ¢ for both mono and di-substituted

ethene-chromium carbony! complexes.'" Interestingly, they found that the di-

substituted cis-Cr(CO)4(C,Hs); complex which has both ethene ligands in
adjacent equatorial positions on the chromium did not isomerize to trans-
Cr(CO)4(C2Ha). Instead, a pseudo-first-order decay to Cr(CO)s(CzHa) was
observed and again the results indicate that the reaction occurs via a dissociative
pathway.

In 1995, McNamara and co-workers reported on work they performed on

the decomposition of various Cr(CO)sL complexes in the gas phase.12 The
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ligands they used were: ethylene, propylene, 1-butene, cis-2-butene, trans-2-
butene, and isobutene. They found that the decay kinetics in all cases were
pseudo-first-order at high L and CO concentrations. Once again, the decay was

shown to follow a dissociative mechanism:

k
d
Cr(CO),L > CHCO)5 +L
k
f
kCO
Cr(CO)5 +CO > Cr(CO)g

They found that the rate of substitution of L by CO increased with increasing
ligand size.

We took an approach similar to that of McNamara et. al. except that we
focused on the dissociation of Cr(CO)sL (L = alkene) in solution. Given the
consistency of previous mechanistic findings, it was not surprising that the
reaction proceeds via a dissociative pathway. Unlike McNamara, however, we
were able to obtain values for both kg and k.. The goal of this work is to obtain
values of kq and ki for many different transition metal-alkene complexes in
solution and to characterize the influence of the electronic and steric properties of

the alkene and the transition metal on the overall stability of these complexes.




Experimental

Organotransition metal complexes are very sensitive to air and must be
handled with extreme care. All solvent purification and solution preparation is
therefore carried out under purified flowing argon. The solution is prepared under
argon inside the photolysis cell, and other than for the addition of 1-hexene, is not
exposed further to air. Each step in the process from solvent purification to
flashing the solution, is presented below. Instructions on using the computer

programs for data analysis are presented in Appendix A.

Argon Purification

All solvent and all reagent handling is done under flowing. Argon gas
(Air Products Inc.) is purified by passing it through 13X molecular sieves
(Aldrich) and an oxygen scavenging column (Aldrich) to remove water, organics,
and oxygen. We have conducted experiments illustrating that even after taking
these measures to purify the argon the kinetic behavior of the highly reactive
orgranotransition metal molecular fragments is affected by something introduced
via the argon stream.
Solvent Purification

Due to the sensitivity of Cr(CO)s to water in the solvent, 99+% heptane
(Aldrich) is subjected to an exhaustive three step drying procedure. In the first
step the solvent is refluxed over CaH; for 12 hours under flowing argon. It is then
transferred to another still and refluxed for an additional 12 hours over NaK.
Lastly, the solvent is distilled in a fractionating column to remove any traces of

CaH,. The first 10mL distilled through the fractionating column is discarded.

12




Then 20mL of heptane is removed with a gas tight syringe for transfer to the

sample cell where the solution is prepared.

Solution Preparation

The empty photolysis cell (Figure 1) is attached to the vacuum line and
exposed to high vacuum for five minutes to remove air and water from the cell.
All solution preparation is done in the cold finger portion of the photolysis cell
where the solution remains until it is flashed. Under flowing argon, 1.0 mg of
99% Cr(COs) (Aldrich) is added to the cell. Experiments have also been
performed using Cr(CO)s which had been purified by sublimation; however, the
results showed that this had no effect on the reaction. At this point, it is necessary
to add the desired amount of ligand, 1-hexene in our current study. Usinga 1:1 1-
hexene:heptane diluted stock solution, the desired amount is added using a micro-
syringe. Using this stock solution and 20mL of solvent, 1pL of the 1:1 1-
hexene:heptane solution corresponds to a concentration of 1-hexene of ImM. The
20mL of purified heptane is then added to the cell and can be used to wash the
Cr(CO)g and 1-hexene down the walls of the cell. A magnetic stirring bar is also
added to permit agitation of the solution while it is attached to the vacuum line.
The concentration of Cr(CO)s in all our runs is 2.0010*M.

After the sample is prepared, it is subjected to four Freeze-Pump-Thaw
cycles t~ remove dissolved gases. This is accomplished by freezing the solution
with liquid nitrogen for ten minutes, pulling high vacuum on it for an additional
ten minutes, closing the stopcock which connects the sample cell to the vacuum

line, allowing the solution to thaw, and finally agitating the solution with a

13




Figure 1 : Photolysis Cell
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magnetic stirring bar for an additional five minutes. After the four Freeze-Pump-

Thaw cycles have been completed, CO is added to the cell.

€O Addition

All of the reactions we study are run under pseudo-first order conditions
with an excess of CO and ligand (1-hexene). Doing this will minimize the
reaction of Cr(CO)s with impurity. The reactions are run under 500 torr of CO.
The CO gas (Matheson) is purified via a two-step process. First, it is passed
through a column of activated charcoal to remove Fe(CO); which may be carried
over from the walls of the steel gas canister. Secondly, the CO is passed through
a dry-ice/ethanol bath (-77°C) to remove condensibles. The CO pressure is
monitored using a simple manometer. In order to obtain an accurate measure of
the CO pressure, the vapor pressure of the solvent must be suppressed. All but
the upper 0.25” of the sample was frozen with liquid nitrogen prior to addition of
CO. If the upper portion of the solution is frozen then it would become possible
for some CO gas to freeze thereby preventing an accurate pressure measurement,

The vapor pressure of the partially frozen solution was found to be negligible.

Flash Experiment and Data Collection

A schematic of the flash apparatus is presented in Figure 2. After placing
the sample cell in the photolyzing housing the solution is ready to be flashed.

A xenon UV/VIS analyzing lamp shines white light down the long axis of
the photolysis cell. When the solution is flashed the concentration of Cr(CO)sL
increases, as Cr(CO)s combines with L, causing a proportional increase in the

absorbance at 380nm. Using Beer’s Law, absorbance can be related to

15




Figure 2 : Flash Photolysis Apparatus Layout
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concentration, thereby allowing us to monitor Cr(CO)sL concentration by tracking
the intensity of the light transmitted by the photolysis cell.

The flashlamps are located on each side of the photolysis cell. The light
from the flashlamps is blocked with CoCl, filter solutions which block light in the
range 340-500nm. The Pyrex photolysis cell also blocks light below 310nm.
These are in place to (1) reduce the scattered light from the flashlamps at the
wavelength (380nm) we are using to track [Cr(CO)sL] and (2) to block high
energy light at A < 300nm that would create other forms of chromium carbonyls
that would react in parallel with the chemistry we are investigating.

The change in absorbance after the solution is flashed is monitored with a
photomultiplier tube (PMT). We selectively monitor the absorbance at 380nm, a
wavelength near the peak absorbance of Cr(COs(1-hexene) (Amax = 370nm) using
a monochromator (ISA Instruments) located directly in front of the PMT.

The output of the PMT is a current proportional to the intensity of the light
entering the PMT. This current is converted to a proportional voltage by passing
it through a simple resistor. The oscilloscope is connected in parallel across the
resistor. Therefore, the change in the absorbance of the solution over time can be
monitored as voltage versus time.

The data is collected on a LeCroy 9410 Dual Beam 150MHz digital
oscilloscope as change in voltage versus time. Using computer software the data

is transferred from the oscilloscope to a computer and then using a program

developed in-house the data is converted to absorbance versus time.




Data Analysis

A detailed set of instructions on how to transfer the data from the
oscilloscope to the computer and also how to use the programs to analyze the data
is presented in Appendix A. However a brief overview is presented here.

The data is transferred from the oscilloscope to the computer using 94g, a
program developed by the oscilloscope manufacturer. Another program, 94tran,
is used to convert the data from binary to ASCII. Voltages, a program developed
in-house, is used to convert the ASCII voltage versus time data to an ASCII
absorbance versus time format.

After the data is converted to absorbance versus time it is imported into
Axum 5.0 (Mathsoft, Inc.) for analysis and plotting. Plots of absorbance versus
time, In absorbance versus time, and inverse absorbance versus time are
generated. From these plots data can be gathered as to whether or not the reaction
returned to the baseline, indicating that no stable products were formed that
absorb at 380nm, as well as information about the order of the reaction. If the In
plot is linear then we know the reaction followed pseudo-first order kinetics as we

expected based on similar studies by others.




Mechanism and Kinetic Equations
The mechanism presented by McNamara et al. in 1995 for the dissociation
of Cr(CO)sL (L = alkene) is restated below.

k
d
Cr(CO) 5 L & Cr(CO) 5+ L
k
f

kCO
Cr(CO)5 +CO - Cr{CO)g

They showed that this mechanism is correct for alkenes in the gas phase that vary
in size from ethylene to iso-butene. The work we are doing currently involves
studying the dissociation of Ct(CO)s(1-hexene). Using flash photolysis with
UV/VIS detection we wish to determine whether the mechanism presented by
McNamara and co-workers holds true for 1-hexene and other alkenes in solution.
In order to correctly interpret the kinetic data collected during the
experiment the neccesary rate equations need to be derived. The following rate

equation can be derived from the above mechanism.
UEHCOLLL k [Cr(CO) LI+ kICHCO)IL]

The lifetime of Cr(CO)s in the absence of added CO in solution has been
reported to be approximately 200us’. Therefore the steady-state approximation
can be applied to Cr(CO)s. Substituting and simplifying gives the following rate

equation.

d[CHCO)sL] [ -k K [CO]
dt - k [L]+k,[CO]

*[Cr(CO),L]

19



At high L and CO concentrations the quantity in brackets is approximately
constant and the reaction becomes pseudo-first order with an observed rate

constant (kobs) of :

|yt

The rate equation can therefore be simplified and written as :
d| L
HCHCOL]_ i [erco)L)

Upon integration the following is obtained :
In [Cr(CO)sL] = -kgpset + In [Cr(CO)sL]o

The concentration of Cr(CO)sL cannot be measured directly. However,
the Beer-Lambert law can be used to relate the absorbance of Cr(CO)sL at 380nm

to it’s concentration.
A380 =gaebe [CI'(CO)sL]

Using the Beer-Lambert law the integrated rate equation can be written as

follows :
In Ajg = -Kopset + 1n Asgop

A linear plot of the natural log of the absorbance of Cr(CO)sL at 380nm
versus time will have a slope of —kons. Upon obtaining this data at various L
concentrations one can use a plot of 1/kebs versus [L] to find ke and k4 from the
slope and y-intercept. We use the value of ko provided by Kelly et al? of

3t1e10°M s

20




k

Keps | K.k oo[COI k,

Moreover, a linear plot of In A;go vs. time combined with a linear plot of

1/kgbs vs. [L] strongly supports our proposed mechanism.

21



Results

A significant amount of time in the summer of 1997 was devoted to
reproducing the work of Kelly et al> This reaction involved simple photolysis of
Cr(CO)s in the absence of added CO. Figure 3 is a typical absorbance versus time
plot for one of these experiments. The absorbance of the solution from time 0 to
0.05s corresponds to the initial absorbance of the solution. The sharp jump att =
0.05s is caused by the firing of the flashlamps and represents the absorbance of
Cr(CO)s or a Cr(CO)s complex at 500nm. Figures 4 and 5 are natural log of
absorbance versus time and inverse absorbance versus time plots for the data in
Figure 3. From Figure 5 it can be seen that the reaction is approaching second-
order behavior but that there is still a competing reaction analogous to the reaction
mentioned by Kelly that formed Cr(Co)X.?

Further examination of Figure 3 shows that there is measurable
absorbance all the way out to 500ms. This is in contrast to the data quoted by
Kelly stating that Cr(CO)s has a lifetime on the order of 200us in the absence of
added CO.? In order to further probe the identity and influence of this impurity,
the time resolved spectrum in Figure 6 was generated.

It was reported by Kelly and co-workers that the absorbance of solvated
Cr(CO)s has a peak at 485+10nm in a mixture of cyclohexane and

perﬂoummethylcyclohexane.4 Perflouromethylcyclohexane was used as a non-

coordinating solvent to investigate the effect of cyclohexane on Cr(CO)s, a

common solvent in Cr(CO)s photochemistry. The absorbance maximum, in

Figure 6, at short times is at approximately 480nm but shifts to the left as it
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cecays. This drift represents the formation of Cr(CO)sX. As stated in the
literature section a common impurity with a peak absorbance less than 480nm is a
Cr(CO)s-water complex. However, many possible impurities also have a peak
absorbance in the same area. One such species is benzene, a common impurity in
cyclohexane. Fortunately, this does not have a large impact on our project
because Cr(CO)s-alkene complexes are known to have a peak absorbance at
wavelengths less than 400nm and the reactions are run in an excess of alkene.
These results led us to pursue methods of solvent purification as our top priority.
The following is a list of some methods tried and their effect.

s Drying of solvent by refluxing with NaK for 12 hours. A time
resolved spectrum showed that this gave better results as the
long time absorbance was shifted closer to 485nm. However,
the impurity was still clearly present and having an effect on
the kinetics.

o Passing the solvent through activated silica gel before refluxing
with CaH; and NaK. This did not have an effect on the
impurity.

e Running the reaction in the presence of additional CO. Adding
CO will force the reaction to follow pseudo-first-order kinetics
and hopefully minimize the effect of the impurity by forcing
Cr(CO)s to reaction with CO. This did not remove the effect of
the impurity and also had the effect of reducing the maximum
absorbance of Cr(CO)s because of its fast reaction with CO.

o Using different grades of solvent and moving from
{ cyclohexane to heptane. Due to the issue of the presence of
benzene in cyclohexane and the preferred use of heptane in IR
work we decided to switch to using heptane. A time resolved
spectrum showed that this did not have an effect on the
impurity.

After devoting two months to the aforementioned experiments, we gave up trying

to further purify our solvents and moved on to doing experiments in which low

27




levels of impurity would not affect the outcome of the reaction. Reactions with
impurities can be minimized by running the reactions we wish to investigate
under pseudo-first-order conditions. This was accomplished by running all
reactions under 500 torr of CO and in the presence of high concentrations of
added ligand, in this case 1-hexene. As shown in the kinetic equations derived
earlier, when the concentration of CO and 1-hexene are both high they can be
considered constant and the proposed mechanism becomes pseudo-first-order.
Figure 17 is a time resolved spectrum of Cr(CO)s(1-hexene) in the presence of

496.5 torr CO. It is clear that the impurity that was altering the kinetics of our

previous study is not having an effect on the kinetics of the dissociation of

Cr(CO)sL. The maximum absorbance, due to Cr(CO)s(1-hexene) occurs at
370nm and remains there throughout the life of the species. The reaction is
monitored at 380nm rather than 370nm because there is less absorbance by
Cr(CO)s at 380nm and therefore the signal-to-noise ratio is much higher at 380nm
than at 370nm.

After eliminating the interference due to the impurity, a series of runs
could be performed on the dissociation of Cr(CO)sL at various L concentrations.
Figures 7 through 16 are plots of absorbance versus time and natural log of
absorbance versus time for 1-hexene concentrations over the range of 0.004M to
0.032M. As the concentration of 1-hexene increases the maximum absorbance
also increases as does the lifetime of the Cr(CO)s(1-hexene) complex. It should
be noted that in some of the experiments the absorbance of the solution does not

return to its initial value. Also, the natural log of absorbance versus time plots are
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not perfectly linear in all cases. This is suggestive of a competing process. The

likely cause of this has been identified and addressed. It is discussed further in
the Discussion section.

In the Kinetic Equations section, the slope of the natural log plots of
Figures 7 through 16 were shown to be — kops. As was also described in the
Kinetic Equations section, a plot of 1/kqps versus 1-hexene concentration should
be linear and can give us values for ke and k4 from the slope and intercept. Data
from the runs presented in Figures 7 through 16, as well as experiments from
other days, are presented in the 1/kqps vs. [1-hexene] plot in Figure 18. There is an
obvious trend which suggests that the proposed mechanism does have merit.
However, the scattering about the best fit line suggests other reactions are also

occurring.




Discussion

As was mentioned in the Results section, there is evidence in the studies
performed on the dissociation of Cr(CO)s(1-hexene) that a process is occurring
that is competing with the dissociation of Cr(CO)sL. We discovered this problem
after sending the UV/VIS analyzing light out for repair. During the repair process
the lens of the lamp housing was cleaned. This allowed a much higher light
intensity to reach the photolysis cell. This, in turn, is now causing significant
photolysis of Cr(CO)s prior to the firing of the flashlamps. This was obvious by
observing the oscilloscope. A change in voltage, and therefore absorbance, could
be seen at 380nm as the cell was exposed to the analyzing light before photolysis.
In light of what is present in the photolysis cell this process likely involves
formation of Cr(CO)s(1-hexene). Possible remedies to the interference and the
direction we took are discussed later in this section.

Although the data collected on the dissociation of Cr(CO)s(1-hexene)
must be refined, some qualitative statements can be made. Table 1 contains the ky
and k; for both our experiment and for other Cr(CO)sL complexes discussed in the
Literature section.

As would be expected solution, the dissociation rate constant we obtained

is less than those obtained by McNamara et al. for a series of alkenes in the gas

phase.12 Rapid energetic quenching by the solvent accounts for this lower value

in the solution phase. It is also interesting to note that the solution phase k¢ we

obtained for




on CO.

d
Cr(CO) 5 L ]((—) Cr(CO) 5+ L
f

[ee]
Cr(CO)4 +CO - Cr(CO),

1-hexene is similar to that for CO obtained by Kelly and co-workers® indicating

that Cr(CO)s’s affinity for alkene n electrons is similar to the lone o-electron pair

Table 1 : Rate Constants for Reactions of

Cr(CO)sL
Solvent L T/I°C ks’ | k/M's” Ref.
C;H;s | 1-hexene R.T. 0.183 3.8¢10° | Our Data
CeH,, CO R.T. 3.10° 3
Gas C,H, 40°C 0.641 12
Phase
Gas C3Hg 40°C 2.6 12
Phase
Gas 1-C4H; 40°C 5.18 12
Phase
Gas cis-2- 40°C 52 12
Phase C,Hg
Gas trans-2- 40°C 22.2 12
Phase C,Hg
Gas i-C4Hg 40°C 22.8 12
Phase
C7F12 N2 R.T. 1.3.10° 4
CsHis HSiEt; 21°C 1.33.107 10
CsHis HSiCl3 21°C 1.54«10° 10
CeH4 HSIEt; 25°C 2.6 10
CesH 4 HSIiCl; 25°C 143 10




The most immediate problem that needs to be addressed is that of

photolysis of the sample by the analyzing light. Two methods to handle this

problem are: A) Filter the analyzing light to block all light below 380nm. B)
Use an IR source instead of UV/VIS. We have elected to use an IR source.

Using an IR source provides many advantages. Peaks are much sharper in
the IR and will make characterizing meta-stable alkene-transition metal
complexes such as Cr(CO)s(1-hexene) easier. The other benefit is the much
lower energy of the infrared light. This will eliminate the problem of photolysis
by the analyzing light completely, since an IR photon carries insufficient energy
to break a Cr-CO bond in Cr(CO)s.

Another advantage of using the IR source lies in the type of photolysis cell
we will be using. Itis a flow through cell and this allows us to replenish the
reaction mixture after each experiment. Due to the short cell path length in an IR
cell, Imm in our case, a large volume of solution is not required to perform a
series of experiments.

Converting to an IR source also has disadvantages. Fortunately, the
necessary equipment is on hand and therefore the large cost of this equipment is
not an issue for us. However, altering the procedure of the experiment this much
will require that a significant amount of time be put into setting up and working
the bugs out of the system. The last two months of this project have been devoted
to this task.

Chromium hexacarbonyl photochemistry has a short history but has been
the focus of much work. Due to it’s use in both catalytic and synthetic
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applications the body of data on Cr(CO)s photochemistry has grown rapidly. A
major goal of this project is to relate the dissociation kinetics of Cr(CO)s-alkene
in the solution phase to that of Cr(CO)s-alkene in the gas phase. While falling
short of this goal, due to problems with the analyzing light, essential preliminary
work has been done. In this project we have laid the groundwork necessary for
definitive results to be obtained on the dissociation Cr(CO)s-alkene complexes in
the solution phase. Future work will be targeted towards obtaining data on the
dissociation of various Cr(CO)s-alkene complexes with alkenes of varying steric

and electronic properties.



Appendix A

1. Transfer the waveform from the LeCroy 9410 oscilloscope to the IBM
Se——enanetorin Irom the LeCroy 9410 oscilloscope to the IBM

computer:

¢ Click on the Start button, go to Programs and then choose MS-DOS
prompt.
Type “cd\94rem” to change to the 94rem directory.
When the trace is on the oscilloscope type “94g”,
Enter “s” to store the trace.
Enter “c1” to save the trace from channel 1.
A generic filename would be FILENAME.BIN. The actual filename is
unimportani, however, it is typically the date. The .BIN is standard.
Enter “e” to exit the program. This must be done after each trace is
saved, as exiting the program returns control to the oscilloscope.

2. Convert the stored trace on the computer from binary to ASCH format:

®  While in the “94rem” directory, use the following command.
94tran -a —oFILENAME.ASC FILENAME.BIN

o The filenames should be identical, aside from the .ASC and .BIN
extensions.

3. Calculate %T and Absorbances from the .ASC file:
~acwlate /01 and Absorbances from the .ASC file

¢ Type “cd\fortran\source\samples”
* Type “voltages”
¢ The list of responses to prompts from the program should be as
follows:
a. “c:\94rem\FILENAME.ASC”
b. 200 (if the time/div is a two) or 250 (if it isn’t)
c. The time/div setting on the oscilloscope in seconds.
d. 1.0V
e. FILENAME.ABS

4. Using Axum for data Drocessing: Importing the data from
FILENAME.ABS:

* Type “exit” (this will return you to windows 95)

¢ Click on Start, go to programs, click on Axum 5.0 and then choose
Axum (if you run Axum from MS-DOS you will get an old version of
Axum).
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Go to the FILE menu and click on IMPORT DATA

o For the file name type “c:\fortran\source\samples\FILENAME.ABS”.

e Position the cursor over each column number and type a column name
(Time, PercentT, and Absorb) respectively.

e For column 1 change the precision to 6.

5. Using Axum for Data Analysis: Calculating In A and 1/A:

Label column 4 as Time2 (change precision to 6).

Label column 5 as Absorb2

Label column 6 as InAbsorb2

Label column 7 as InvAbsorb2

Scan the data looking for the row just after the firing of the flash

lamps (a sudden drop in PercentT will be present).

o Highlight only the Time and Absorbance columns from just after the
lamps were fired until A =0.02.

e Copy each column and paste the Time column into Time2 and the
Absorb column into Absorb2.

e Click the Transform toolbar button (it is a capital X).

In the window type :

\6=Ln(\5);
\7=1/(\5);

The first line means: “Calculate the natural logarithm of each entry in
column 5 and place the result in the same row of column 6.”

The second line means: “Calculate the inverse of each entry in column 5
and place the result in the same row of column 7.”
e Save the data sheet.

6. Using Axum for Data Graphing: Plotting Absorbance vs. Time:

s Holding down the control key, click on the Time and Absorb columns.
e Click on the 2-D plot option (it is located on the top toolbar next to the
transform option).
e From the graph menu click on the Scatter option (top left).
o A plot of the data will appear.
Adding a Title:
e Go to the Insert menu and click on Titles.
e Choose Main and type in a one line title.
o Ifasecond line is needed select Sub from the Titles menu. Typically
this is used for the date and run number.
Labeling the Axes:
e Click on the label of the axes you wish to change.
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The label will be editable. Enter the new label and click out of the
editing area.

7. Graphing In A and 1/A vs. Time:

Hold down the control key and select the Time2 and either InAbsorb
or InvAbsorb column.
Click on 2-D plot.
Click on the Linear fit option.
To name and change axes labels follow the directions in part 6.
To display the equation of the best fit line do the following:
a. Go to the Insert menu.
b. Click on Curve Fit Equation
c. Use the mouse to drag the equation to the desired
location.
Save the plot.

8. Opening an existing data sheet or graph:

Go to the File menu.

Choose Open

Choose Union Chem (C:)

Choose Fortran

Choose Source

Choose Samples

Choose or type in the desired file.

9. Constructing a Time Resolved Spectrum:

Do steps 1, 2, and 3 from above first.

Open Axum and make a new worksheet.

Label the first column Time and change the precision to 6.

Label the next column Absorb_Xnm where X is the wavelength.

Initially give this column the same number as your greatest

wavelength, then label successive columns with the lower |
wavelengths. |
Save the worksheet.

Select Import Data from the File menu.

Open the Absorbance file that corresponds to your first reading

(highest wavelength).

Copy the Time column from this worksheet and paste it into the Time

column of the other worksheet.

Now copy the absorbance column and paste it into the first worksheet

in the Absorb_Xnm column that corresponds to that wavelength.
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Close the file that you copied from and open the file of the next lowest
wavelength.

Copy and paste the absorbance as you did before. Do this for every
wavelength. Only copy the Time from the first worksheet.

Now after all the wavelengths are in place save the worksheet again
and also create and save a new worksheet.

Label the first column in the new worksheet Wavelength. Enter each
wavelength you observed into this column

Label the remaining columns with Absorb_X where X is a time
division. For example, if you had 1ms/div. your first column would be
Absorb_0ms, followed be Absorb_1ms, and so on until you had as
many points as you desired (10 max.).

Now go back to the old worksheet and highlight the row that
corresponds to your first time.

Select transpose from the Data menu and select row. The on the right
side of the window change the worksheet field to display the “new”
worksheet and change the column field to display the appropriate
column (i.e. for time = 1ms change to Absorb_lms).

The first row of your Absorbance columns will contain the entry in the
Time column from the “old” worksheet b/c Axum transposes the entire
row. Highlight the first row of every column except for the
Wavelength column and then select Clear from the edit menu. This
will clear the data and move the data in every column except for the
Wavelength column up one row.

Once you have transposed all the times save the worksheet again.
To create the spectrum, highlight all of the columns and select
Scatter/Line from the graphing toolbar. This will construct the plot.
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